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PUBLIC NOTICE
FEDERAL COMMUNICATIONS COMMISSION News Media Information: (202) 418-0500

445 12th STREET, S.W. Fax-On-Demand: (202) 418-2830
WASHINGTON, D.C.  20554 Internet: http://www.fcc.gov

ftp.fcc.gov

DA 00-1582
July 14, 2000

AM Auction Remedial Filing Window

Notice and Filing Requirements Regarding July 31 – August 4, 2000
Remedial Filing Window for AM Auction

The Wireless Telecommunications Bureau and the Mass Media Bureau (collectively
the “Bureaus”) announce an AM auction remedial filing window for corrective submissions by
entities that timely filed only one of the two documents required by Commission AM auction
procedures.  Those entities will be permitted to supplement their prior submissions, between
July 31, 2000, and August 4, 2000 (“AM Auction Remedial Window”), by filing either the
previously omitted FCC Form 175 or the FCC Form 301 Section I and Tech Box of Section
III-A.

Background.  On November 19, 1999, a public notice was released announcing an AM
auction filing window for applications for new AM stations and major modifications to
authorized AM facilities.1  The January Filing Window Public Notice required that entities
interested in participating in the AM auction electronically file a FCC Form 175 (short-form
application) during the January Filing Window and, concurrently, file a FCC Form 301 Section
I and the Tech Box from Section III-A, if they had not done so previously.  The Bureaus
cautioned that the failure of any entity to file all required information on a timely basis would
preclude that entity’s participation in the AM auction proceeding.2  Nonetheless, the

                                                
1  See AM Auction Filing Window and Application Freeze; Notice and Filing Requirements Regarding

January 24 – 28, 2000 Window for Certain AM Construction Permits; Notice Regarding Freeze on the
Acceptance of AM Minor Change Construction Permits from December 24, 1999 to January 21, 2000, Public
Notice, 14 FCC Rcd 19490 (1999) (“January Filing Window Public Notice”).  The January Filing Window Public
Notice announced that there would be a five day filing period from January 24, to January 28, 2000 (“January
Filing Window”) for the filing of applications for new AM stations and major modifications to authorized AM
facilities.  The filing period was subsequently extended to February 1, 2000.  See AM Auction Filing Window and
Application Freeze Extended to February 1, 2000, Public Notice, 15 FCC Rcd 1910 (2000).

2  See January Filing Window Public Notice, 14 FCC Rcd at 19492, 19494, 19495; see also

http://www.fcc.gov/
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Commission received ten filings, listed in Attachment A, that did not comply with the filing
requirements set forth in the January Filing Window Public Notice.

AM Auction Remedial Window.  Generally, participation in prior auctions conducted
by the Bureaus required the filing of only FCC Form 175.3  The AM auction (“Auction No.
32”) filing window is the first to employ filing procedures which require the concurrent filing
of FCC Form 175 and the engineering data contained in FCC Form 301.  The Bureaus
recognize that potential applicants may have experienced some confusion in the Bureaus’
initial use of the two-part procedure.  The purpose of the AM Auction Remedial Window is to
allow those entities that only filed FCC Form 175 or the required engineering data on FCC
Form 301 a short period of time to correct their filings to comply with our rules.  We caution
that this is a unique opportunity offered by the Bureaus.  We do not anticipate offering such an
opportunity in future auction proceedings.

Only entities identified in Attachment A may make corrective submissions during the
AM Auction Remedial Window.  In order to be eligible to participate in Auction No. 32, those
entities must correct their submissions as described below:

•  If an entity has a pending FCC Form 301 application (Frozen AM Application) and
did not timely file a FCC Form 175 during the January Filing Window, that entity
must electronically file a FCC Form 175 by 6:00 p.m. Eastern Standard Time,
August 4, 2000.  For more information regarding the completion and electronic
filing of the FCC Form 175, see Attachments A, B, and C of the January Filing
Window Public Notice, Attachments B and C to this public notice which replace
attachments D and E of the January Filing Window Public Notice,4 and the
instructions set forth in “Electronic Filing Procedures for FCC Form 175,” infra.
Such entities should specify the file number of their pending FCC Form 301
(Frozen AM Application) in FCC Form 175, Exhibit E (“Miscellaneous
Information”).

                                                                                                                                                         
Implementation of Section 309(j) of the Communications Act -- Competitive Bidding for Commercial Broadcast
and Instructional Television Fixed Service Licenses, Reexamination of the Policy Statement on Comparative
Broadcast Hearings, Proposals to Reform the Commission’s Comparative Hearing Process to Expedite the
Resolution of Cases, First Report and Order, 13 FCC Rcd 15920, 15974, 15975 (1998) (“First Report and
Order”); 47 C.F.R. § 73.3571(h)(ii).

3  In recently completed Closed Broadcast Auctions No. 25, No. 27 and No. 28, applicants who had
previously submitted long form applications were subsequently required to file FCC Forms 175 to participate in a
closed broadcast auction.  Applicants were eligible to bid only on those construction permits for which they had
previously filed long form applications.  See First Report and Order, 13 FCC Rcd at 15920.

4  Effective Monday, July 17, 2000, the Bureau will permit the filing of FCC Form 175 applications
("short-form applications") via the Internet.  As a result, two of the attachments previously provided in the
January Filing Window Public Notice have been updated.  Specifically, the Bureau has amended Attachments D
and E of the January Filing Window Public Notice.  See January Filing Window Public Notice, Attachments D
and E.  Fully updated copies of those attachments are attached hereto as Attachments B and C.
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•  If an entity timely filed a FCC Form 175 during the January Filing Window and did
not file the required engineering data sections of FCC Form 301, that entity must
file FCC Form 301 (May 1999 version) Section I and the Tech Box of Section
III-A.  These sections of FCC Form 301 must be filed in triplicate with the
Secretary of the Commission, 445 12th Street, S.W., Washington, D.C. 20554.  The
required engineering data sections of the FCC Form 301 are due in hard copy by
7:00 p.m. Eastern Standard Time, August 4, 2000.  No filing fee is required.  A
courtesy copy of any Form 301 submission filed during the AM Auction Remedial
Window should also be sent to James R. Crutchfield, Audio Services Division,
Room 2-B450, at the above street address.  For more information regarding the
completion of the required engineering data sections of the FCC Form 301, see
Attachment A of the January Filing Window Public Notice which provides
guidance regarding completion of the required FCC Form 301 sections.  Such
entities should specify, in the cover letter accompanying the required FCC Form
301 sections or at the top of the first page of the FCC Form 301 submission, the
account number of the associated pending FCC Form 175 as indicated in
Attachment A to this public notice.  It is not necessary for such entities to include a
printed copy of their previous, electronically filed FCC Form 175 with the FCC
Form 301 submission.

•  If an entity filed the required FCC Form 301 engineering data or a complete FCC
Form 301 during the January Filing Window and did not file an associated FCC
Form 175, that entity must electronically file a FCC Form 175 by 6:00 p.m. Eastern
Standard Time, August 4, 2000.  For more information regarding the completion
and electronic filing of the FCC Form 175, see Attachments A, B, and C of the
January Filing Window Public Notice, Attachments B and C to this public notice
which replace attachments D and E of the January Filing Window Public Notice,5

and the instructions set forth in “Electronic Filing Procedures for FCC Form 175,”
infra.  In FCC Form 175, Exhibit E (“Miscellaneous Information”), such entities
should cross reference the city, state, frequency, and call sign identified in their
previously filed FCC Form 301 required sections.

Failure of any entity identified in Attachment A to have all required forms and information
timely and properly filed by August 4, 2000 will result in the dismissal of any prior
submissions relating to the January Filing Window for AM applications.

Electronic Filing Procedures for FCC Form 175.   Only the entities identified in Attachment
A that are required to complete a FCC Form 175 will be able to make corrective filings in the
AM Auction Remedial Window.  Each of these entities will receive via Federal Express an
assigned temporary tax identification number (TIN) and password.  This assigned temporary
TIN and password will be required to access the FCC Form 175 submission software.

After the application has been submitted, the applicant will be required to write a letter to the
Commission requesting a change to their TIN.  The letter should contain the company name,

                                                
5  See supra n.4.
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FCC account number, assigned temporary TIN and the company's actual TIN.  This letter
should contain language authorizing the Commission to replace the assigned temporary TIN
with the company's actual TIN.  This letter requesting a TIN change should be addressed to
Amy Zoslov, Chief, Auctions and Industry Analysis Division, Wireless Telecommunications
Bureau, Federal Communications Commission, 445 12th Street, S.W., Washington, D.C.
20554.  A separate copy of the letter should be mailed to Kenneth Burnley, Auctions and
Industry Analysis Division, 4-B524, Wireless Telecommunications Bureau, Federal
Communications Commission, 445 12th Street, S.W., Washington, D.C. 20554.

For additional information, please contact:  Kenneth Burnley, Legal Branch, Auctions and
Industry Analysis Division, Wireless Telecommunications Bureau at (202) 418-0660; Jean
Ann McGovern at the Audio Services Division, Mass Media Bureau at (202) 418-2700.

-FCC-
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ATTACHMENT A

Pending FCC Form 301 Application – No Record of a Timely Filed FCC Form 175

FILE NUMBER APPLICANT CITY/STATE CALL SIGN

BP-971002AB J. L. Richardson Hartman, AR NEW

FCC Form 175 Filed – No Record of Timely Filed Required FCC Form 301 Sections

ACCOUNT NUMBER APPLICANT

0321947494 IHR Educational Broadcasting 

0320223328 William R. Green

0321343452 Steven V. Beilfuss

Required FCC Form 301 Sections Filed Between January 21, and February 1, 2000 – No
Record of a Timely Filed Associated FCC Form 175

APPLICANT CITY/STATE CALL SIGN

William B. McCarter  Suwanee, GA NEW

Radio WEBS, Inc. Calhoun, GA  WEBS

Sage-Com, Inc. Redmond, OR NEW

1090 Investments, L. L. C. Livonia, MI WCAR

1090 Investments, L.L.C. Owosso, MI WOAP

Dominant Communications Corp of MS Flowood, MS NEW
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ATTACHMENT B

ELECTRONIC FILING AND REVIEW
OF THE FCC FORM 175

Applicants must submit their FCC Form 175 applications electronically, using either the FCC
Auctions System page on the Internet or the Commission's remote access system.  The remote
access system will generally be available 24 hours per day.  FCC Form 175 applications must
be submitted and confirmed by 6:00 p.m. ET on Friday, August 4, 2000.  Late applications or
unconfirmed submissions of electronic data will not be accepted.

Applicants must press the 175 Submit button on the Submit page to successfully submit their
FCC Form 175.  The electronic filing process consists of an initial filing period and a
resubmission period to make minor corrections.  During each filing period, submitted
applications may be updated and amended multiple times until the filing deadline.

A. Minimum Hardware and Software Requirements

Applicants will need to meet the following minimum hardware and software requirements:

1. Minimum Hardware Requirements

•  CPU:  Intel Pentium
•  RAM: 16 MB (more recommended if you have multiple applications open)
•  Modem:  28.8 Kbps Hayes compatible modem or faster (recommend 56.6 Kbps)
•  Monitor:  VGA or above
•  Mouse or other pointing device

2. Minimum Software Requirements

•  Operating System: Microsoft Windows 95 or 98

•  PPP (Point-to-Point Protocol) Dialer: Use the Dial-Up Networking feature included with
Windows 95/98

•  Web Browser:  Netscape Communicator 4.73 is recommended.  However, you can also use
Netscape Communicator 4.5, 4.51, 4.61, 4.7, or 4.72 (Internet web browser software).

Note:  To download Netscape Communicator 4.73 free of charge, access the Netscape
download site at http://home.netscape.com/download/

•  PDF Viewer:  Adobe Acrobat Reader 3.0 or higher (available at http://www.adobe.com)

•  If you wish to use the download feature in the Form 175 Review, you will need a .tar file
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extraction utility, e.g., Winzip (available at http://www.winzip.com) or Pkzip for Windows
(available at http://www.pkware.com/download.html).

B. Submitting FCC Form 175 Applications

You can submit FCC Form 175 applications electronically via the Internet.  Start your
Netscape Web browser.  In your browser’s Location field, enter http://wtbwww15.fcc.gov and
then click 175 Submit.

Note:  If you have problems with the Internet, you may submit FCC Form 175
applications via the FCC Wide-Area Network, using Dial-Up Networking.  For details,
refer to the Accessing the FCC Network to File FCC Form 175 attachment.

When uploading attachments in FCC Form 175 Submission, applicants may use a variety of
file formats -- including Word 97 or earlier, WordPerfect 6.x or earlier, Adobe PDF, and ASCII
text -- and should verify that the files contain all exhibit information.  Graphics file uploads
(e.g., .bmp, .tiff, .jpg) and spreadsheets (e.g., Excel, Lotus) are not supported, and graphics
images should not be imported into any word processing files that are uploaded.  Do not
upload a password-protected file.  The FCC system will not be able to open it or convert it.

After you upload an attachment and it has been converted, check to see if it converted properly
by selecting the PDF filename in the rightmost column. The conversion process generally
completes within thirty minutes.  If you are unable to read this file after it has been converted,
please do the following:

1. Re-upload the attachment.

2. If the file still has not converted properly, then simplify the formatting of the file.

For example, if you are using a Table structure in a WordPerfect document, remove the
Table structure and leave the contents of the table, then re-upload the attachment.

After you have successfully re-uploaded an attachment, please delete the old, unreadable
attachment files.

Applicants must press the Submit Form 175 button on the Submit page to successfully submit
their FCC Form 175.  Pressing Submit Form 175 produces a confirmation message showing
the assigned FCC Account Number.  During each filing period, submitted applications may be
updated and amended multiple times until the filing deadline.
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C. Reviewing FCC Form 175 Applications

Once the FCC has completed the 175 Review process, you can review FCC Form 175
applications electronically via the Internet.  Start your Netscape Web browser.  In your
browser’s Location field, enter http://wtbwww15.fcc.gov and then click 175 Review.

D. Help

For technical assistance with installing or using FCC software, contact the FCC Technical
Support Hotline at (202) 414-1250 (V) or (202) 414-1255 (TTY).  The FCC Technical Support
Hotline is generally available Monday through Friday from 7 a.m. to 10 p.m. ET, Saturday
from 8 a.m. to 7 p.m. ET, and Sunday from 12 p.m. to 6 p.m. ET.  All calls to the FCC
Technical Support Hotline are recorded.
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ATTACHMENT C

ACCESSING THE FCC NETWORK
TO FILE FCC FORM 175

This attachment describes how to access the FCC Network from a system that is running the
Microsoft Windows 95 or Microsoft Windows 98 operating system.  This involves configuring
dial-up network access and then performing the dial-up procedure.

Note:  Dial-up access to the FCC Network is not required to submit or review FCC
Form 175 applications.  You can perform those functions from the Internet, by entering
location http://wtbwww15.fcc.gov/ on your Netscape Web browser and clicking the 175
Submit or 175 Review button, respectively.  For more details, refer to the Electronic
Filing and Review of the FCC Form 175 attachment.

Conventions

The instructions in this section use the following typographical conventions:

bold Represents objects on the screen that you click with the mouse pointer,
including buttons, Internet links, icons, tabs, menu items (e.g., Cancel button,
Auctions link, Save option in the File menu).

italic Represents field names or areas of a screen (e.g., Applicant field, Selected
Licenses area of a screen).

bold italic Represents characters that you must type exactly as they appear in the
instructions.  For example, if you are instructed to type
http://wtbwww15.fcc.gov, you should type all of the characters shown in bold
italic exactly as they are printed.

SMALL CAPS Represents keys on the keyboard (e.g., ENTER, CTRL, ESC).

Note:  Throughout these instructions, “enter” means to type the appropriate information and
then press the ENTER key.

A. Accessing the FCC Network to Submit FCC Form 175 Applications
The following section provides the instructions for configuring the dial-up network access in
preparation for submitting FCC Form 175 applications.  The subsequent section gives the dial-
up procedure.

1. Configuring Dial-Up Networking

1. To start dial-up networking:
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a. Click the Windows 95/98 Start button.
b. Click the Programs option to display the Programs menu.
c. Click the Accessories option to display the Accessories menu.
d. In Windows 95, click Dial-Up Networking.

In Windows 98, click Communications, then Dial-Up Networking.

If Dial-Up Networking is not an option on your Accessories menu, you should install
it from your Windows 95/98 CD or diskettes.

2. When the Dial-Up Networking window appears, double-click the Make New
Connection icon.

The Make New Connection window appears.

3. Type FCC Auctions 800# in the field titled Type a name for the computer you are
dialing.

4. In Windows 95, click the down arrow at the right of the Select a modem field and select
your modem from the menu of available modems.

In Windows 98, click the down arrow at the right of the Select a device field and select
your modem from the menu of available devices.

If your modem does not appear on this list, you must install your modem driver
according to the modem manufacturer installation procedures, which are usually
described in your modem’s user manual.

5. Click the Next button.

6. Type 800 and 378-7435 in the Area Code and Telephone Number fields, respectively.

If you need to dial 9 or some other digit to get an outside line, include that digit in the
Area Code field.  For example, you might type 9, 1 800 in this field.

7. Verify that the correct country is selected in the Country code field.

If necessary, click the down arrow at the right of the Country code field and select the
appropriate country from the menu of available countries.

8. Click the Next button.

9. Click the Finish button.

An icon labeled FCC Auctions 800# appears in the Dial-Up Networking window.
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10. Verify that properties are configured correctly before attempting a dial-up session.  Put
the mouse pointer on the icon and click the right mouse button to display a menu.
Click Properties from the menu.

11. Click the Configure button.  Click the Options tab at the top of the Properties window.

12. In the Connection control area of the Options tab, verify that neither option is selected.
If either option is selected, click the check box at the left of the option to deselect it.
Then click OK.

13. In Windows 95, click the Server Type... button.

In Windows 98, click the Server Types tab at the top of the Properties window.

14. In the Advanced Options area, verify that only Enable software compression is
selected.  If it is not selected, click the check box at the left of the option to select it.  If
either of the other options is selected, click the check box to deselect it.

15. In the Allowed Network Protocols area, verify that only TCP/IP is selected.

If it is not selected, click the check box at the left of the option to select it.  If either of
the other options is selected, click the check box to deselect it.

16. Click the TCP/IP Settings button.  On the TCP/IP Settings window, select Server
assigned IP addresses at the top and select Specify name server addresses midway
down the window.

17. Type 165.135.241.149 as the Primary DNS and 165.135.79.95 as the Secondary DNS.

Ensure that these two options are checked:

•  Use IP header compression
•  Use default gateway or remote network

18. Click OK on the TCP/IP Settings window and the Server Type window.

19. Close the Dial-Up Networking window.

20. a. Click the Windows 95/98 Start button, then click the Settings option to display the
Settings menu.

b. Click Control Panel and then double-click the Network icon.

c. Highlight the TCP/IP Protocol and click Properties.  If there are multiple TCP/IP
protocols, highlight TCP/IP --> Dial-Up Adapter and click Properties.
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In a Windows 98 environment, a confirmation dialog appears.  Read the
information on the dialog, then click the OK button.

d. Click the DNS Configuration tab and then click the Enable DNS radio button at
the top.

e. Type bidder in the Host box, type fcc.gov in the Domain box, then type
165.135.241.149 and 165.135.79.95 in the first two DNS Server Search Order
boxes and click the Add button.

Note:  You are limited to three DNS entries.  If you already have three DNS entries,
you must delete two of them before performing this step.  To do this, click the first
entry you want to delete and click the Remove button.  Then click the second entry
you want to delete and click the Remove button again.

f. Click OK on the TCP/IP Properties windows, then click OK on the Network
windows.

g. If you are prompted to restart your computer, click Yes to restart, then begin the
Dial-Up Procedure.

2. Dial-Up Procedure

1. If the Dial-Up Networking window is not currently open, do the following:

a. Click the Windows 95/98 Start button.
b. Click the Programs option to display the Programs menu.
c. Click the Accessories option to display the Accessories menu.
d. In Windows 95, click Dial-Up Networking

In Windows 98, click Communications, then Dial-Up Networking.

The Dial-Up Networking window appears.

2. In the Dial-Up Networking window, double-click the FCC Auctions 800# icon.

3. Click the Connect button on the window.  Do not enter User name and Password.

The Connection window appears, indicating the status of your connection as your modem
dials into the system.  This window must remain running during your dial-up session.
You may minimize the window, if you wish.

If your modem fails to establish a connection, please see the Troubleshooting section.

B. Submitting FCC Form 175 Applications
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After you have connected to the FCC Network, start your Netscape Web browser.  In your
browser’s Location field, enter http://wtbwww15.fcc.gov (primary location) or
http://wtbwww04.fcc.gov (secondary location) and then click 175 Submit.

Note:  The wtbwww04 location can only be accessed through dial-up networking; it
cannot be accessed through the Internet.

When uploading attachments in FCC Form 175 Submission, applicants may use a variety of
file formats -- including Word 97 or earlier, WordPerfect 6.x or earlier, Adobe PDF, and ASCII
text -- and should verify that the files contain all exhibit information.  Graphics file uploads
(e.g., .bmp, .tiff, .jpg) and spreadsheets (e.g., Excel, Lotus) are not supported, and graphics
images should not be imported into any word processing files that are uploaded.  Do not
upload a password-protected file.  The FCC system will not be able to open it or convert it.

After you upload an attachment and it has been converted, check to see if it converted properly
by selecting the PDF filename in the rightmost column. The conversion process generally
completes within thirty minutes.  If you are unable to read this file after it has been converted,
please do the following:

1. Re-upload the attachment.

2. If the file still has not converted properly, then simplify the formatting of the file.

For example, if you are using a Table structure in a WordPerfect document, remove the
Table structure and leave the contents of the table, then re-upload the attachment.

After you have successfully re-uploaded an attachment, please delete the old, unreadable
attachment files.

Applicants must press the Submit Form 175 button on the Submit page to successfully submit
their FCC Form 175.  Pressing Submit Form 175 produces a confirmation message showing
the assigned FCC Account Number.  During each filing period, submitted applications may be
updated and amended multiple times until the filing deadline.

When you have finished, exit your Web browser; then click the Disconnect button on the
Connection window to end your dial-up session.

C. Removing the Dial-Up Networking Service

Once you have finished using the dial-up networking service, you can remove it from your
computer, as follows:

1. Click the Windows 95/98 Start button, then click the Settings option to display the
Settings menu.

2. Click Control Panel and then double-click the Network icon.
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3. Highlight the TCP/IP Protocol and click Properties.  If there are multiple TCP/IP
protocols, highlight TCP/IP --> Dial-Up Adapter and click Properties.

In a Windows 98 environment, a confirmation dialog appears.  Read the information on the
dialog, then click the OK button.

4. Click the DNS Configuration tab.

5. Click the DNS Server Search Order box containing 165.135.241.149 to select it, then click
the Remove button.

6. Similarly, click the DNS Server Search Order box containing 165.135.79.95 to select it,
then click the Remove button.

7. Click OK on the TCP/IP Properties windows, then click OK on the Network windows.

8. If you are prompted to restart your computer, click Yes to restart.

9. Remove the FCC Auctions 800# icon from your desktop.  That is, click the icon with your
right mouse button and then click the Delete option in the pull-down menu.

D. Troubleshooting

Following are problems you may encounter and possible solutions for resolving or isolating
them.

1. Modem does not respond

1. Confirm that all physical connections for the modem are present.

2. Confirm that the phone line is active by connecting it to a telephone and checking for a
dial-tone.

3. Confirm that the correct modem driver is installed for your modem.

2. Modem dials but does not connect

1. Confirm that the number the modem is dialing is correct.

2. Confirm that the modem prefix, if any, is correct.

Using a Backup Dial-In Number.  If the number and prefix are correct, the 800 number being
dialed may be experiencing problems.  In this case, you can reconfigure the dial-up software
using an alternate dial-in number, which is also toll-free.  To use the backup number, perform
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the Configuring Dial-Up Networking procedure again, but this time make the following
changes:

•  In Step 3, type FCC Auctions 877# in the field titled Type a name for the computer you are
dialing.

•  In Step 6, type 877 and 844-2788 in the Area Code and Telephone Number fields,
respectively.

•  In Step 17, type 165.135.79.95 as the Primary DNS.

•  In Step 20e, type 165.135.79.95 in the DNS Server Search Order box.

3. Modem dials and connects, but nothing appears when you enter
the Location in the Web browser

1. Verify the Dial-Up Networking settings specified in the Configuring Dial-Up Networking
section.

2. Confirm that your Web browser is not using proxies:

a) On your browser, click the Preferences option in the Edit menu.
b) In the Category area at the left, double-click Advanced.
c) Click the Advanced structure’s Proxies option.
d) Click the radio button labeled Direct connection to the Internet.
e) Click the OK button at the bottom of the window.

4. Receive an Internal Server error in the Web browser

1. Confirm that the Location is set to http://wtbwww15.fcc.gov or http://wtbwww04.fcc.gov

2. On your browser, click the Preferences option in the Edit menu.  In the Category area at
the left, double-click Advanced.  In the area at the top, confirm that Enable Java and
Enable JavaScript are selected.  In the Cookies area, confirm that Accept all cookies is
selected.

E. Help

For technical assistance with installing or using FCC software, contact the FCC Technical
Support Hotline at (202) 414-1250 (V) or (202) 414-1255 (TTY).  The FCC Technical Support
Hotline is generally available Monday through Friday from 7 a.m. to 10 p.m. ET, Saturday
from 8 a.m. to 7 p.m. ET, and Sunday from 12 p.m. to 6 p.m. ET.  All calls to the FCC
Technical Support Hotline are recorded.
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